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1. Introduction 

This guide provides an introduction to using NetX360 and is intended primarily for new NetX360 users.  

Note: Availability of NetX360 features is determined by entitlements. You may not be entitled to access 

or view all the features described in this guide. 

Additional Resources 

Additional online resources are available to help you learn and use NetX360: 

• Training, including instructional videos, is available on the Client Training Services page. 

• A helpful place to begin orientation on NetX360 is the NetX360 Features & Capabilities video. 

• Help and other documentation are available on the NetX360 Learning Center (see below). 

Learning Center 

The Learning Center is the home page for NetX360 documentation where you can search for 

documentation or access documents by category. 

 

http://www.brainshark.com/pershing/FL_NetX_PAS?dm=5
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Types of Documentation 

The following documentation is available on the NetX360 Learning Center. 

DOCUMENT TYPE DESCRIPTION 

User Guide Provides full details about a particular application or feature, including detailed 

descriptions of features, step-by-step procedures, screen shots and supplemental 

reference material. 

Task Reference Documents a step-by-step procedure for performing a task, along with related 

information you need to know to perform the task. 

Reference 

Material 

Provides information that you may need to refer to as you complete a task, such as 

codes, field descriptions and other related information. 

What's New 

(Release Notes) 

Provides a description of new and enhanced features in a release. 

You can also find many other documents on the Learning Center, including forms, brochures and 

bulletins. 

Access the Learning Center 

You can access the Learning Center several different ways: 

• Click  Help on the Utility menu (see Utility Menu on page 21). 

Or 

• Press F1. 

Or 

• Click Resources > Learning Center. 

The Learning Center home page displays. 

Search for Documentation 

 In the Learning Center Search field, enter keywords for the desired subject and click Go. A list of search results 

displays. 

 To narrow the search results, select a category or document type from the boxes on the right.  

 To move among pages of search results,  click Next or Prev above or below the search results.  

 Select the desired document from the search results. The selected document displays.  
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Access Documentation by Category 

1. On the Learning Center page, select the desired documentation category: 

o Click Show Categories from the Learning Center home page to display a list of sub-

categories (see screen shot below). Click the desired sub-category. 

Or 

o Click the category name in the Category box on the right side of the Learning Center page 

that contains search results (see  above). 

A list of documents in the selected category displays. 

2. Select the desired document. The selected document displays. 
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Training 

Client Training Services offers tools to help support your NetX360 learning and educational needs, 

including instructional videos, a calendar of live instructor-led events, self-guided learning opportunities 

and a comprehensive course catalog. 

Access the Client Training Services Page 

1. Click Resources > Learning Center. The Learning Center home page displays. 

Global search keywords: learning center. 

2. Click Client Training Services in the upper right. The Client Training Services page displays. 

 

Forms 

Forms, applications, agreements, and certifications are available on Marketing Center (click Resources > 

Marketing Center). 
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2. Get Started 

This section shows how to perform some basic tasks in NetX360, including how to: 

• Log in to NetX360 

• Change your NetX360 password 

• Update your login security information 

• Submit feedback 

• Export data to Microsoft® Excel® or PDF 

Log In to NetX360 

NetX360 offers two login methods that provide extra security if the system does not recognize your 

device. 

• One-Time Passcode (OTP) - Request and receive a temporary code that is sent to a pre-registered 

device to confirm your identity. See below. 

• Security Questions - Answer a preset security question to confirm your identity. See Log In to 

NetX360 Using Security Questions on page 11. 

Log In to NetX360 Using One-Time Passcode (OTP) 

NetX360 uses One-Time Passcode (OTP) to provide multi-factor authentication for extra security (such as 

instances where the system does not recognize your device). You can receive and enter a temporary 

passcode that is sent to a pre-registered device to confirm your identity. 

If you see the screens shown below when logging in to NetX360, you are set up to use OTP for login 

identity verification. If not, see Log In to NetX360 Using Security Questions on page 11. 

Set Up Your One-Time Passcode Contact Methods 

When you log in to NetX360 for the first time (after an installation), you can set up contact methods by 

which NetX360 sends you requests to enter a One-Time Passcode. 

1. Launch NetX360 from the Start menu or the icon on your desktop. The first time you do this after 

installation, the Connectivity window displays. 

2. Click OK. NetX360 sets up your computer and network environment. The splash page displays, 

and when setup is complete, the NetX360 Login page displays. 
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3. Enter your user ID and password. If your computer is secure, select Remember User ID and click 

Continue. The One-Time Passcode Setup page displays. 

 

4. Click Add Another Device to enter a new contact method. 

5. Select the contact method, enter or select an email address or phone number (enter a country 

code if entitled), enter a nickname, and then click Verify. The system sends a passcode to your 

new device and displays the Verify Your Device pop-up. 

Note: The passcode expires after 10 minutes. 
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6. Enter or copy and paste in the passcode and click Verify. The One-Time Passcode page re-

displays, and the Verified icon  displays to the right of the added contact method. 

7. In the Remember My Device section, select Yes or No (clicking Yes causes the system to 

remember your device for 30 days). 

8. Click Continue. The Security Email Setup page displays. 

You must enter an email address where NetX360 can send you security alert notifications on your 

account. 

 

9. Click the Select Email Address drop-down arrow and select Add a New Email. 

10. Enter the email address twice to confirm it, then click Save. A confirmation message displays. Click 

OK. 

Note: To revise the security email address, click Settings > Security Settings > Security Email. 

The Security Email Address page displays. 

Log In Using One-Time Passcode 

When you log in to NetX360 from a new or unrecognized device, you must confirm your identity by 

receiving and entering a temporary passcode that is sent to a pre-registered device. 



2. GET STARTED 

FOR INVESTMENT PROFESSIONAL USE ONLY. NOT FOR DISTRIBUTION TO THE PUBLIC. 

GETTING STARTED WITH NETX360 USER GUIDE 

10 

1. On the NetX360 Log In page, enter your User ID and password and click Continue. 

If NetX360 does not recognize your device, the One-Time Passcode page displays. 

 

2. Click the Contact Method drop-down list and select one of your preset device nicknames. 

3. Click Send Code. NetX360 sends a communication to you that contains your One-Time Passcode. 

Enter or copy and paste in the passcode. 

Note: The passcode expires after 10 minutes. 

4. In the Remember My Device section, select Yes or No (clicking Yes causes the system to 

remember your device for 30 days). 

5. Click Continue. The Log In page re-displays, and the system loads the home page. You are now 

ready to use NetX360. 
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Change Your One-Time Passcode Contact Methods 

When you edit an existing contact method, the Verified status is removed, and the contact method is 

deactivated. The contact method you edit will be treated as new and you must verify it after making the 

changes. 

1. Click the Settings icon  on the Utility menu (see Utility Menu on page 21). 

2. Enter your password and click Continue, then on the Security Settings page click One-Time 

Passcode. 

 

3. Follow steps 4-7 of the procedure Set Up Your One-Time Passcode Contact Methods on page 7. 

4. Click Save. A confirmation message displays. Click Continue. A second confirmation message 

displays. Click OK. 

Forgot Password 

You can log in to NetX360 using OTP if you have forgotten your password. 

1. On the NetX360 Log In page, click Forgot Password. 

2. Enter your User ID and Personal Identification Number (PIN, a four-digit number you previously 

created to use in conjunction with other methods to authenticate your identity) and click 

Continue. The One-Time Passcode page displays. 

3. Follow steps 2-5 of the Log In Using One-Time Passcode procedure above. 

Log In to NetX360 Using Security Questions 

NetX360 uses security questions to provide extra security if the system does not recognize your device. 

You can then answer a preset security question to confirm your identity. 
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If you see the screens shown below when logging in to NetX360, you are set up to use security questions 

for login identity verification. If not, see Log In to NetX360 Using One-Time Passcode (OTP) on page 7. 

Set Up Your Security Questions 

When you log in to NetX360 for the first time (after an installation), you must confirm your identity by 

setting up three security questions and their answers. 

1. Launch NetX360 from the Start menu or the icon on your desktop. The first time you do this after 

installation, the Connectivity window displays. 

2. Click OK. NetX360 sets up your computer and network environment. The splash page displays, 

and when setup is complete, the NetX360 Login page displays. 

 

3. Enter your user ID and password. If your computer is secure, select Remember User ID and click 

Continue. 

If this is your first time using NetX360 after installation, or if you are accessing NetX360 from an 

unrecognized device, the Security Setup page displays. 

4. Select three required security questions and enter the answers using the guidelines listed on the 

page. 

Tip: To view your answers, deselect Mask Responses. 

5. Select Yes or No in response to the question: Would you like to access NetX360 from this device 

in the future without the need for additional security questions? 

Note: If you are using a public computer, it is recommended that you select No. 

6. Click Save. A confirmation message displays. Click OK. 

Log In Using Security Questions 

1. On the NetX360 Log In page, enter your User ID and Password and click Continue. 
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If NetX360 does not recognize your device, you are asked to validate your session by answering 

the security questions that you previously selected. 

2. Enter your answer to the security question, select Yes or No in response to Remember this 

computer for 30 days? and click Continue. The NetX360 window opens and the home page 

loads. You are now ready to use NetX360. 

Change Your Security Questions 

You can select the security questions that display when you log in to NetX360 from a new or 

unrecognized device. You can also change your security questions or your answers to them. 

Guidelines for Answers to Security Questions 

• You must select and answer three questions. 

• All answers must be unique. You cannot use the same answer for more than one question. 

• Answers must consist of at least three alphanumeric characters. 

• Valid characters in answers are alphanumeric characters and spaces. 

Change Your Security Questions 

1. Click the Settings icon  on the Utility menu (see Utility Menu on page 21). 

2. Click Security Settings. The Provide Password window displays. 

3. Enter your password, click Continue and then click Security Questions. The Security Setup - 

Questions page displays. 

 

4. Follow steps 4-6 of the procedure Set Up Your Security Questions on page 12. 
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Forgot Password 

You can log in to NetX360 using security questions if you have forgotten your password. 

1. On the NetX360 Log In page, click Forgot Password. The Forgot Password page displays. 

2. Enter your User ID and PIN number and click Continue. The second Forgot Password page 

displays. 

3. Enter the answers to all three of your security questions and click Submit. The Reset Password 

page displays. 

4. Enter and confirm your new password (conforming to the Password Rules list displayed on the 

page), enter your PIN and then click Continue. A confirmation message displays. Click OK. The 

NetX360 Login page re-displays. 

5. Enter your User ID and new password and click Continue. The NetX360 window opens and the 

home page loads. 

Change Your NetX360 Password 

NetX360 requires you to change your password every 60 days, and prompts you when you need to do so. 

You can change your password sooner than 60 days. 

Password Guidelines 

• Must be eight characters in length. 

• Must contain at least one alphabetic and one numeric character. 

• Cannot contain repeating characters. 

• Cannot be the same as, or the reverse of, your user ID. 

• Cannot contain your first or last name. 

• Cannot repeat any of your last 13 passwords. 

• Cannot contain days of the week or months of the year. 

Check When Your NetX360 Password Will Expire 

• Click the arrow next to your name in the upper right corner of the NetX360 window. A message 

informs you how many days are left before your password will expire. 
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Change Your NetX360 Password 

1. Click the Settings icon  on the Utility menu (see Utility Menu on page 21). 

2. Click Security Settings. The Provide Password page displays. 

3. Enter your password and click Continue. The Change Password page displays. 

 

4. Enter your old password, your new password (conforming to the Password Rules list displayed on 

the page) and a confirmation of your new password, and click Save. A confirmation message 

displays. Click OK. 

5. Select Yes or No in response to the question: Would you like to access NetX360 from this device 

in the future without the need for additional security questions? 

Note: If you are using a public computer, it is recommended that you select No. 

6. Click Save. A confirmation message displays. Click OK. 

Submit Your Feedback 

Your feedback is an important part of the process of enhancing NetX360 to include the features that users 

need most. 

Submit Your Feedback 

1. Click the Feedback  icon on the Utility menu (see Utility Menu on page 21). The Feedback 

Tool window displays. 

2. Populate fields on this window and click Send. A confirmation message displays. 
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Export Data to Excel or PDF 

If an Excel icon  or PDF icon  displays on a NetX360 page, you can export data to those formats. 

• Click the Excel  or PDF icon . The data displays in the selected format and lists the filter criteria. 
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3. Navigate 

NetX360 provides a simple, intuitive interface for easy navigation, including: 

• Customizable home page 

• Communications 

• Robust search capabilities 

• Standard NetX360 menu 

• Favorites - your own customizable menu 

• Tools 

• Tabbed pages to enable multitasking 

Note: In the following scenarios, previously configured settings will be lost: 

• Migrate from NetX360 32-bit version to 64-bit version 

• Install 64-bit version after installing 32-bit version 

You must manually set up the following settings once during your initial login. NetX360 will remember 

these settings and preferences during your subsequent logins. Other settings such as grid settings, last 

accessed accounts, and favorites will be retrieved from the server during your initial login.  

• Popup window location 

• Popup window resize 

• Recently viewed 

• Remember tabs 

Home Page 

The dashboard, your NetX360 home page, displays when you log in to NetX360. The dashboard is 

customizable and allows you to select the information you want to display. You can: 

• Add, remove and move content tiles to create your own custom view. 

• Add up to five pages, with up to 10 content tiles per page. 

• Rename the dashboard. 

• Change the office or advisor (IP) level of the data. 

View Your Home Page 

• When you log in to NetX360, your home page displays. 

• From anywhere in NetX360, click the  Home tab to view your home page. 
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Change the Office or Advisor Level of Data Displayed 

• Change the filters in the context passing field in the upper left. 

Move to the Next or Previous Page 

• To move to the previous page of content on your home page, click the arrow on the left side of 

your home page. If there is no arrow on the left, you are on the first page. 

• To move to the next page of content on your home page, click the arrow on the right side of your 

home page. If there is no arrow on the right, you are on the last page. 

• The circle icons at the bottom indicate which page is displayed. 
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Smart Scroll 

Smart scroll enables you to use the vertical scroll bar to scroll up or down a page without the contents of 

the page moving with the scroll. When you stop scrolling and release the mouse button, the page view 

moves up or down to the level of the new position of the scroll bar.  

1. Click the Settings icon  on the Utility menu (see Utility Menu on page 21). 

2. Click Table Display 

3. To change your preference from smart scroll (the default) to the normal scroll bar, deselect the 

Smart Scroll check box. 

Tip: You can also use the arrow keys on the keyboard or the scrolling wheel on the mouse to 

navigate. 
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Communications Center 

Communications Center, which appears as a permanent tile on your home page, displays messages about 

upcoming events and other key updates. 

Communications Center always displays on your home page and cannot be deleted. 

 

View a Message in Communications Center 

1. In the Communications Center tile on your home page, select Messages and double-click the 

message you want to view. The selected message displays in a pop-up. 

o To view the next message in the list, click Next. 

o To view the previous message in the list, click Previous. 

2. To close the pop-up, click the X icon in the upper right. 

 

View Other Types of Communications 

1. In the Communications Center tile on your home page, select a category. A list of documents for 

the selected category displays. 

2. Click the link for the document you want to view. The selected document displays in Adobe® 

Reader® or Adobe Acrobat®. 
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Utility Menu 

The Utility menu, which displays in the top-right of the NetX360 window, allows you to perform actions 

such as printing data and adding favorites. The options on the Utility menu vary based on the page you 

are currently viewing. 

You have the flexibility to display the Utility menu the way that works best for you: 

• Click the Utility menu icon to display the menu (as shown in the screen shot below). 

 

Or 

• Drag the Utility menu border to the left to display the icons on the menu bar (as shown in the 

screen shot below). The menu icons remain visible on all NetX360 pages. You can drag the border 

back to hide the icons and access the menu as shown above. 
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Search NetX360 

NetX360's global search capabilities enable you to search all areas of NetX360 to find the account, feature 

or information you need. By default, the search covers all areas of NetX360. If desired, you can narrow the 

search by selecting a category from the drop-down list. 

You can enter an account number, client name, security symbol or other search criteria in the search field 

at the top of the page. 

As you enter your search criteria, matching items display in the search results. 

Note: NetX360 also offers advanced search capabilities. See Advanced Search on page 23. 

 

Search NetX360 

 In the global search field at the top of the page, select a category to search from the drop -down list. 

Otherwise, leave the default selection of All, which searches all areas of NetX360.  

 Enter your search criteria, which can be an account number, client name, security symbol or any other desired 

criteria. As you type, NetX360 displays all matching search results by category.  

 Click a row in the search return list to display it.  

 To filter your search return list, click the Settings icon  to display a pop-up of available filters. Click the 

check box of a filter to select it, make any further selections or entries in the Advanced panel fields, then click 

Submit. 
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Advanced Search 

In addition to the standard global search capabilities described above, NetX360 provides advanced search 

functions to search by: 

• Account 

• Household or group 

• Security 

Use Advanced Search 

1. Click the Advanced Search icon  at the top of the NetX360 window. 

2. Select the type of search at the top of the page: Account, Household/Group, or Security.  

3. Enter your search criteria and click Search. Search results display. 

Note: If your search returns a large number of results, the More button displays above and to 

the right of the search results. Click More to view additional results. 
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Menu 

Access functions using the NetX360 menu. 

For easy identification, the currently displayed menu name appears in blue on the top navigation bar . For 

example, the Reports & Documents menu heading is blue and the available options for that menu 

display below. 

 

Access the Menu 

• Click Menu (near the top-left of the page) or press F10. The NetX360 menu displays. 

Pin the Menu 

• Click the Pin Menu icon at the right end of the menu ribbon. The menu ribbon displays near 

the top of the main NetX360 page (and the Menu button no longer displays). 

Tip: Shortcut keys are also available for many features. The shortcut key appears to the right of the 

feature name if available. See Shortcut Keys on page 73. 
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Favorites 

You can create a list of your favorite NetX360 features and pages, as well as external websites for easy 

access. 

 

Access Favorites 

• Click Favorites (near the top-left of the page). 

Or 

• Click  View Favorites on the Utility menu (see Utility Menu on page 21). 

Or 

• From a new tab, click a Favorites folder at the top of the tab and select the desired feature. 

Tools 

NetX360 Tools provides access to features that are available through integration or subscription. 
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Access Tools 

• Click the Tools icon  in the upper right (as shown in the screen shot). Click the tool you want 

to access from the list. 

Tabbed Pages 

You can open more than one NetX360 feature at a time using tabs, allowing you to easily move from one 

task to another. You can open up to 10 tabs at once, including the Home tab. 

 

Open a New Tab 

1. Do one of the following: 

o Click the tab with the + symbol, located to the right of currently open tabs (see screen shot 

below). 

Or 

o Right-click on a tab and select New Tab. 

A new tab displays, listing up to 16 recently viewed pages. 

2. If the feature you want to open appears in the Recently Viewed list, click the tile to open it. 

Otherwise, open the feature using the search field or a Favorites folder at the top of the tab. 
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Display a Favorite from a New Tab 

The folders you have created in Favorites display across the top of new tabs. 

• To quickly launch a feature you have added to Favorites, click a Favorites folder at the top of the 

tab and select the desired feature. 

Add a Feature to Favorites from a New Tab 

1. Move your mouse over a tile on a new tab. The  Add to Favorites icon displays in the upper 

right corner of the tile. 

2. Click the Add to Favorites icon. 

Copy the Content in a Tab to Another Tab 

• Right-click on the desired tab and select Copy to New Tab. 

Close a Tab 

Note: You cannot close the Home tab. 

• Click the X to the right of the tab name. 

Or 

• Right-click on the tab name and select Close Tab. 

Close All Tabs Except the Currently Selected Tab 

• Right-click on a tab and select Close Other Tabs. 

Launch the Current Tab in a Separate Window 

• Right-click on the desired tab and select Launch in New Window. 

Or 

• If the Drag to Launch Tab option is enabled (see below), click and drag the desired tab. 

Enable or Disable the Drag to Launch Tab Option 

1. Click  Settings on the Utility menu (see Utility Menu on page 21).  

2. Select the Preferences tab. 

3. Select or deselect the Drag to Launch Tab check box as desired and click OK. 

Re-attach a Tab That Was Launched in a Separate Window 

• Right-click on the tab within the separate window and select Re-attach Tab. 
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4. Customize 

This section describes NetX360 customization capabilities, including: 

• Customizing your home page 

• Setting your preferences 

• Adding and managing your favorites 

You can also customize the account workbook summary page (see page 58) and account data views (see 

page 61). 

Customize Your Home Page 

You can customize your home page as follows: 

• Rename the page 

• Select a two-column or three-column layout 

• Add, remove and move content tiles to create your preferred layout 

• Add up to five pages, with up to 10 content tiles per page 

• Change the office or advisor (IP) level of the data 

Rename Your Home Page 

1. Double-click the home page name in the upper left. An editable field displays. 

2. Enter a new name for the home page (up to 18 characters) and press Enter. 
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Select a Layout for Your Home Page 

You can select a two-column or three-column layout for your home page. 

1. Click  Settings on the Utility menu (see Utility Menu on page 21). 

2. Select the Preferences tab. 

3. In the Home Page field, select 3 Columns or 2 Columns and click OK. 
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Add Content to Your Home Page 

You can add up to five pages of content to your home page, with up to 10 content tiles per page. 

1. Click + Add Content in the upper right. The Add Content page displays. 

2. Locate the content you want to add by doing one of the following: 

o To search for content, enter the first few letters of the desired content in the search field and 

press Enter. A list of matching content tiles displays. 

Or 

o To select content by category, select a content category from the list on the left or select All 

to view all content. A list of content tiles in the selected category displays. 

To sort the content tiles, select the desired option from the Sort by field. 

New content tiles display a New tag in the upper right. The categories on the left indicate the 

number of new content tiles. 

3. Click Add in the content tile you want to add. The Choose Page pop-up displays. Click the radio 

button of the existing page to display the content tile there (or click New Page to start a new 

page) and then click Add. 

4. When you have finished adding content, click the X icon in the upper right. The selected content 

tiles are added to the selected page.  

Note: When all content tiles are removed from a dashboard page, that page is automatically 

deleted. 
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Move a Content Tile in Your Home Page 

• Click the title bar of the content tile and drag it to the desired position within your home page. 

Remove a Content Tile From Your Home Page 

• Click the X in the upper right corner of the content tile. 

Set Your Preferences 

The Settings window includes many settings to customize NetX360. Settings are organized by category 

on tabs. 

 

Set Your Preferences 

1. Click  Settings on the Utility menu (see Utility Menu on page 21). 

2. Click the Preferences tab on the left. Set your preferences as desired and click OK. 
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Logout and Lockout Settings 

Your NetX360 Logout and Lockout settings control the amount of idle time that is allowed on your 

session before the system automatically locks or logs you out. 

SETTING DESCRIPTION POSSIBLE VALUES 

Logout Specifies the amount of idle time allowed on a locked session 

before you are automatically logged out. If you are logged out, 

you must enter your NetX360 login ID and password to start a 

new session. 

Five to 500 minutes. Must 

be greater than or equal 

to Lockout setting. 

Lockout Specifies the amount of idle time allowed on an active session 

before you are automatically locked out. If you are locked out, you 

must enter your NetX360 password to resume your session. 

If you are locked out, you will be logged out after the remaining 

number of minutes specified for the Logout setting. A message 

informs you of the time remaining before you will be logged out. 

Five to 500 minutes. Must 

be less than or equal to 

Logout setting. 

Specify Logout and Lockout Settings 

1. Click the Settings icon  on the Utility menu (see Utility Menu on page 21). 

2. Select the Security Settings tab.  

3. Enter your NetX360 password and click Continue. 

4. Click Auto Logout/Lockout, select the desired settings and click Save. 
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Manage Your Favorites 

You can manage your favorites as follows: 

• Add a favorite 

• Create and delete folders 

• Move a favorite from one folder to another 

• Delete a favorite 

Add to Favorites 

Adding favorites helps you quickly access the NetX360 features you use most often. When you add a 

favorite, you can include or exclude the office and advisor (IP) context. You can also add links to external 

websites. 
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Add a NetX360 Feature or Page to Favorites 

1. Open the desired page or feature. 

2. Do one of the following: 

o Click  Add to Favorites on the Utilities menu (see Utility Menu on page 21). 

Or 

o Right-click on the tab name and select Add to Favorites. 

3. Make sure Current Tab is selected. 

4. The currently selected office and advisor (IP) context displays. To save the feature with this 

context, select With; otherwise, select Without. 

5. Indicate the folder where you want to save the new favorite: 

o Select an existing folder from the list at the bottom of the window. 

Or 

o To add a new folder, enter the folder name in the Create In field and click Add. 

6. Click OK. 

 



4. CUSTOMIZE 

FOR INVESTMENT PROFESSIONAL USE ONLY. NOT FOR DISTRIBUTION TO THE PUBLIC. 

GETTING STARTED WITH NETX360 USER GUIDE 

35 

Add an External URL to Favorites 

1. Do one of the following: 

o Click  Add to Favorites on the Utilities menu (see Utility Menu on page 21). 

Or 

o Right-click on the tab name and select Add to Favorites. 

2. Select the External URL tab and enter a display name and the URL. 

3. Indicate the folder where you want to save the URL: 

o Select an existing folder from the list at the bottom of the window. 

Or 

o To add a new folder, enter the folder name in the Create In field and click Add. 

4. Click OK. 
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Manage Your Favorites 

1. Click Favorites at the top of the page. 

2. Click Organize Favorites. 

o To add a new folder, enter the name in the field at the top of the window and click Add. 

o To move a favorite from one folder to another, drag the feature to the desired folder. 

o To reorder favorites within a folder, select a feature name and drag it to the desired position 

within the folder. 

o To delete a favorite or folder, select it and click Delete. 

3. When you are finished making changes, click OK. 
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Create Households and Account Groups 

You can organize your accounts into households and account groups to view and analyze related account 

data. 

You can create groups of accounts and “super groups” that consist of multiple groups.  

Households 

A household is a group of up to 50 related accounts. All households have a public access level. 

The Create Households wizard guides you through creating a new household. The wizard consists of three 

steps: 

1. Create New Household 

2. Set Household Attributes (optional) 

3. Set Display Criteria (optional) 

You can create households that are groups of accounts, as well as “super households” that consist of 

multiple households. 

Select a Primary Account 

Each household must have a primary account, which determines the client name, address and contact 

information for the household. When you create a household, the oldest account is designated as the 

primary account by default. If desired, you can select a different primary account. See Set Household 

Attributes below. 
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Create a Household 

1. Click Accounts > All Accounts > Households/Groups. The Households/Groups page displays. 

Global search keyword: households. 

2. Click the wrench icon  next to Households and select Create Household(s). 

 

Step 1: Add Accounts to the Household 

1. On the Create/Modify Households tab of the Create Households page, search for accounts to 

add to the new household: 

o Enter values for one or more filters. 

o Click Go. The search results display in the left panel. 

2. Build the list of accounts for the new household in the right panel. 

o To add an account to the household, select it in the left panel and click Add. 

o To remove an account from the household, select it in the right panel and click Remove. 

Use Ctrl+click to select multiple non-adjacent accounts, or Shift+click to select multiple adjacent 

accounts. 

You can sort the accounts by account number, SSN/TIN or short name by clicking on the column 

header. 

When you select an account in the left panel, the system suggests related accounts that you can 

add to the household in the Related Accounts section. 
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3. Enter a name for the new household (up to 32 characters) above the list of accounts in the right 

panel. 

4. Change the order of accounts within the household using the Move Up  and Move Down  

icons. 

5. To create a sub-group within the household: 

o Click Add Sub Level. 

o Enter a name for the sub-group and press Enter. 

o Add accounts to the sub-group from the left panel, or drag accounts in the right panel to the 

sub-group. 

o To remove the sub-group, click Remove Sub Level. The sub-group is removed, but the 

accounts in the sub-group are still in the household. 

6. When you are done adding accounts, click Create. A confirmation message displays. Click OK. 

7. Do one of the following: 

o If you want to modify the primary account or household name, click Next. Go on to Set 

Household Attributes below. 

o If you are done, click Close. 

Step 2: Set Household Attributes 

On the Set Household Attributes page, you can modify the primary account or household name. 

1. Select the household you want to modify. To sort the list, click on a column header. 

2. By default, the oldest account is designated as the primary account. To select a different primary 

account, click in the Primary Account column and select the desired account from the list. 

3. To modify the household name, click in the Household Name column and enter a new name (up 

to 32 characters). 

4. Do one of the following: 

o If you want to modify the primary account or household name, click Next. Go on to Set 

Display Criteria below. 

o If you are done, click Close. 

Step 3: Set Display Criteria 

On the Set Display Criteria page, you can select the households that you want to display on the 

Households/Groups page. You can also select sorting criteria for households and accounts. 

1.  On the My Households tab, select the households that you want to display on the 

Households/Groups page: 

o All households 

o Households created by me 

o Manually select households. If you select this option, build the list of households in the right 

panel as follows: 

• Select one or both of the check boxes: Created by Me and Created by Others. The list 

below updates with the selected households. 

• If desired, filter the list by selecting Households starting with, enter your filter criteria in 

the adjacent field and click Go. Matching households display in the list below. 
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• To add a household to the display list, select it in the left panel and click Add to move it 

to the right panel. Click Add All to add all households. 

• To remove a household from the display, select it in the right panel and click Remove. 

Click Remove All to remove all households. 

2. On the Sorting Criteria tab, indicate how you want to sort households in the 

Households/Groups page. 

o In the Households field, select ascending or descending by household name. 

o In the Accounts field, select ascending or descending by short name. 

3. When you are done, click Finish. The Create Households wizard closes. 

Create a Group of Households 

You can create a “super household” that consists of multiple households. 

• Follow the procedure above to create a household and select the households you want to include 

from the All Households tab.  

Account Groups 

An account group is a collection of related accounts created for viewing and analyzing consolidated 

information. The accounts in the group generally have a factor in common, such the account type or 

positions in a specific investment. Account groups can contain any number of accounts and can be set to 

access levels of public, private or shared. 

You can create groups of accounts and “super groups” that consist of multiple groups.  

Access Levels 

Account groups can have the following access levels: 

ACCESS LEVEL DESCRIPTION 

Public Users who are entitled to the accounts in a group can view the group. 

Private Only you can view the group. 

Shared Specified users can view the group. 
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Create an Account Group 

1. Click Accounts > All Accounts > Households/Groups. The Households/Groups page displays. 

Global search keyword: households. 

2. Click the wrench icon  next to Other Groups and select Create New Group. 

 

3. Search for accounts to add to the new account group: 

o Enter values for one or more filters. 

o Click Display. The search results display in the left panel. 

4. Build the list of accounts for the new account group in the right panel. 

o To add an account to the group, select it in the left panel and click Add. 

o To remove an account from the group, select it in the right panel and click Remove. 

Use Ctrl+click to select multiple non-adjacent accounts, or Shift+click to select multiple adjacent 

accounts. 

You can sort the accounts by account number, SSN/TIN or short name by clicking on the column 

header. 

5. Enter a name for the new account group (up to 32 characters) above the list of accounts in the 

right panel. 

6. Select the desired access level for the account group: public, private or shared. 

7. To add the account group to a billing group for Management Fee Center (MFC), select the 

Management Fee Billing Group check box. 

8. When you are done adding accounts, click Save. A confirmation message displays. 

o If you want to create another account group, click Yes. 

o If not, click No. The Create Other Group page closes. 

Create a Group of Groups 

You can create a “super group” that consists of multiple account groups. 

• Follow the procedure above to create an account group and select the groups you want to 

include from the Groups tab.  
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5. View Client Accounts 

The NetX360 account workbook displays client account information. The account workbook includes a 

summary page and detail pages such as balances, holdings, and activity. You can view the account 

workbook at various levels: 

• Single account 

• Household or account group. See page 54. 

• Office or advisor (IP). See page 53. 

• All accounts. See page 53. 

You can customize the data views that display in the account workbook. See page 61.  

Search for an Account 

1. In the NetX360 search field, select Account. 

2. Enter the first few characters of the account number or short name. Matching accounts display. 

The number of matching items displays in parentheses on the left. Click Accounts to view the full 

list. 

3. Select the desired account. The account workbook summary page displays.  
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Account Workbook Summary Page 

The account workbook summary page provides an overview of the account. You can customize this page 

to suit your needs. See Customize the Account Workbook Summary Page on page 58. 

 

Detail Pages 

Account workbook detail pages provide more detailed information for an account, to help you monitor 

and analyze your business. 

• Activity 

• Balances 

• Documents 

• Holdings 

• Items for Attention (IFA) 

• Notes (Availability is based on entitlements. Some users have view-only access.) 

• Order/Trade Status 

• Performance 

• Profile 

• Projected Cash Flow 

• Revenue Summary (Availability is based on entitlements.) 
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You can customize the data that displays on detail pages by sorting, filtering, selecting the displayed data 

columns and changing the order of data columns. See Customize a Data View on page 61. 

You can also customize the account summary that displays at the top of the page. See Customize the 

Account Data Summary on page 65. 

Note for Bank Custody Accounts 

The data that displays in the account workbook for bank custody accounts may differ slightly from what 

you see in the screen shots below. 

View an Account Workbook Detail Page 

1. From the account workbook summary page, click the title bar of a content tile. The detail page for 

that content displays. Other available detail pages are listed in the left panel. 

2. To view a different detail page, click the page name in the left panel. 
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Display a Different View of a Detail Page 

Account workbook detail pages include multiple view options for the data. For example, the Holdings 

page includes options for positions, gains and losses, asset distribution, and so on. Click a link at the top 

of the page to display a different view. If there are too many links to fit across the page, More… displays. 

Click the arrow to the right  to view additional links. 

 

Holdings 

The Holdings - Positions page displays position value in both position and base currencies, as well as 

gains and losses. 

 

Activity 

The Activity - Intraday Activity page displays activity within the account as of the current day (weekend 

activity displays on the first business day of the week). 
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Documents 

The Documents page displays online account-related documentation (such as E-Document Suite™, 

Imaged Documents and Client Meeting Reports). 

 

Balances 

The Balances page displays balances for an account, as intraday values or as of previous business day’s 

close. 
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Order/Trade Status 

The Order/Trade Status page displays open and recently executed orders based on product type. 

 

Items for Attention 

The Items for Attention (IFA) page allows you to monitor and react to a wide range of events (such as 

action items and for your information (FYI) items) for a single account, across a group of accounts or by 

office or advisor (IP). See View Notifications on page 68.  
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Projected Cash Flow 

The Projected Cash Flow – Incoming Cash page displays announced and projected income for positions 

within the account. 

 

Profile 

The Profile page contains account identification, contact information and sub account details, such as 

balance type and currency. 

 



5. VIEW CLIENT ACCOUNTS 

FOR INVESTMENT PROFESSIONAL USE ONLY. NOT FOR DISTRIBUTION TO THE PUBLIC. 

GETTING STARTED WITH NETX360 USER GUIDE 

49 

Navigate Account Workbook Detail Pages 

View the Account data Summary or Profile 

1. Click the Account Information icon  next to the context field. The Profile window displays. 

 

2. To view the full account profile, click Full View at the bottom of the window. 

3. To view the account data summary, click Account Data Summary at the top of the window. 
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View a Different Account 

• In the context field in the upper left, do one of the following: 

o Enter a different account number. 

Or 

o Click the arrow on the right to view a list of recently viewed accounts. Select the desired 

account. 

The account summary page for the selected account displays. 

 

Go Back to the Account Workbook Summary Page 

• From any account workbook detail page, click  at the top of the left panel. 

Display a Different Detail Page 

• Click the detail page name in the left panel. 
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Display a Predefined View 

1. Click View above the data grid. 

2. Under Views, select the desired view. 

3. Click Apply. 

 

Show or Hide the Details Panel 

Many account workbook detail pages include a details panel in the lower portion of the page. 

• To show the details panel, click the Expand icon  in the lower right. 

• If the details panel includes more than one tab, click the tab name at the top of the details panel 

to view that tab. The example below includes three tabs: Security Info, Memo and Tax Lot Info. 

• To hide the details panel, click the Collapse icon . 
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Split Page View 

Split page view displays two account information pages side by side. 

To split the page view, click and drag a second page name (from the vertical list on the far-left side of the 

page) past the dotted box (that displays while dragging on the left side of the panel) to the right side of 

the panel. The second selected page now displays in the right side of the panel.  
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View Account Information for All Accounts 

You can view all entitled accounts in a single list. From this list, you can: 

• Filter by office or advisor (IP). 

• Navigate to the account workbook at the office or advisor level. 

 

View All Accounts 

• Click Accounts > All Accounts > Accounts. The All Accounts page displays. 

Global search keywords: all accounts. 

View Account Information at the Office or Advisor Level 

1. In the context field at the top of the window, enter the desired office and advisor (IP) numbers. To 

select all, enter ALL, as shown in the example above. 

2. Press Enter. The page refreshes to display data at the specified level. 

3. Click Navigate to Workbook next to the context field. The account workbook opens in a new 

tab. 



5. VIEW CLIENT ACCOUNTS 

FOR INVESTMENT PROFESSIONAL USE ONLY. NOT FOR DISTRIBUTION TO THE PUBLIC. 

GETTING STARTED WITH NETX360 USER GUIDE 

54 

View an Individual Account 

• In the all accounts, office or advisor level view, double-click on the row for the desired account. 

The account workbook for the selected account opens in a new tab. 

Change the Level of Data Displayed 

1. In the NetX360 search field, select IBD-OFF-IP. 

2. In the search field, enter the desired criteria or select from the list of available options. The 

account workbook summary page displays at the selected level. 

3. To change the level of data displayed, do one of the following in the context field in the upper 

left: 

o Enter a different office or IP number and press Enter. 

Or 

o Click the arrow in the context field to view a list of recent selections. The example below 

shows recent office selections. 

 

View Account Information at the Household or Group Level 

 

1. In the NetX360 search field, select Household/Group. 

2. Enter the first few characters of the household or group name or number. Matching search results 

display. 
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3. Select the desired household or group from the search results. The account workbook summary 

page for the selected household or group displays. 

4. If you want to change the level of data displayed, do one of the following in the context field in 

the upper left: 

o Enter a different household or group number and press Enter. 

Or 

o Click the arrow in the context field to view a list of recent selections. 

View Client Account Documents 

The account workbook Documents page displays client account-related documents. 

Documents Sent to Investors: e-Document Suite 

e-Document Suite stores client account documents that are sent to clients, including confirms, statements, 

reports, tax documents, and notifications. 

From the e-Document Suite page, you can view documents at various levels: 

• Single account 

• Household or account group 

• Office or advisor (IP) 

View Client Documents 

1. From the account workbook, display the Documents page and select e-Document Suite. 

2. Use the search criteria fields to search for the desired documents. 

3. Click Display. e-Document Suite displays matching documents (up to 3,000 documents). 

4. To view a document, click View in the Action column. 
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Documents Received from Investors: Imaged Documents 

NetX360 Imaged Documents enables you to store and manage documents related to client accounts.  

Document Types 

You can store the following types of documents in Imaged Documents: 

• Tagged image file format (TIF) 

• Adobe PDF 

• Microsoft Word (.doc or .docx) 

• Microsoft Excel (.xls or .xlsx) 

• Microsoft PowerPoint (.ppt or .pptx)  

View a Document and Related Information 

1. From the account workbook, display the Documents page and select Imaged Documents. 

2. To filter the list of files: 

o Click Criteria above the document list. Document filters display. 

o Populate one or more filter fields. 

o Click Display. 

3. Click the document link for the desired document in the Document Type—Description column. 

A pop-up displays. The Indexes tab displays additional detail about the document. 

 



5. VIEW CLIENT ACCOUNTS 

FOR INVESTMENT PROFESSIONAL USE ONLY. NOT FOR DISTRIBUTION TO THE PUBLIC. 

GETTING STARTED WITH NETX360 USER GUIDE 

57 

Upload a Document to Imaged Documents 

1. From the account workbook, display the Documents page and select Imaged Documents. 

2. Click Upload Documents in the upper right, and under Step 1: Browse & Select Documents, 

select the file you want to upload. 

3. Click Select for Upload. A preview of the selected document, if available, displays in the Preview 

section. 

4. Under Step 2: Indexing, select the document type from the Document Type field. Index 

information fields for the selected document type display below. 

5. Populate index information fields for the document. Required fields are marked with an asterisk 

(*). 

6. Under Step 3: Upload, click Upload. The Upload Status window informs you of the upload 

progress. When the upload is complete, a confirmation message displays. Click OK. 

7. Upload another document or click the X button in the upper right to close the window. 
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Customize the Account Workbook Summary Page 

You can customize the account workbook summary page to suit your needs: 

• Select a two-column or three-column layout 

• Customize the tab display name 

• Add, move or remove content tiles 
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Select Settings for the Account Workbook Summary Page 

1. Click  Settings on the Utility menu (see Utility Menu on page 21). 

2. Select the Preferences tab. 

3. Select options in the Tab Display Name and Workbook fields as desired (see screen shot below). 

4. Click OK. 
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Add Content to the Summary Page 

1. Click + Add Content in the upper right. The Add Content page displays. 

 

2. Click Add in the content tile you want to add. If the content tile displays Added, it displays on the 

summary page. 

 

3. When you are done adding content, click the X icon in the upper right. The selected content tiles 

are added. If desired, you can move the content tiles on the summary page as described below. 

Move a Content Tile on the Summary Page 

• Click the title bar of the content tile and drag it to the desired location. 

Remove a Content Tile from the Summary Page 

• Click the X in the upper right corner of the content tile. 
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Customize a Data View 

The NetX360 account workbook provides many options for customizing data views that display in a grid.  

 

Filter Data Using Additional Filters 

Some account workbook detail pages include additional pre-defined filters. If available, these filters 

display below the page title. 

The filters you select here remain in effect when you start a new NetX360 session, or when you log in to 

NetX360 from a different computer. 

1. Click the filters bar. The filters expand. 

2. Select the desired filter options. 

3. Click Display. The data grid displays with the selected filter options. 
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Remove Filters 

1. Click the filters bar again. 

2. Click Reset, then Display. The filters are removed. 

Filter Data by a Column 

1. Select the Filter check box above the data grid. A filter row displays below the header row. 

2. In the column you want to filter, click the operator icon  and select the desired operator from 

the list. 

3. Indicate the value on which you want to filter by doing one of the following: 

o Enter the desired value in the adjacent field. 

Or 

o Click the down arrow  on the right and select the desired value. 

In this example, the Position Value column is filtered for values that are greater than or equal to 

1,000. 

 

4. If you selected Custom, the Custom Filter Selection window displays. Click Add Condition. 
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5. Select an operator and operand. 

6. If desired, add additional conditions. You can use And/Or groups to further refine the results. 

Click Toggle to switch between And and Or. A summary of your conditions displays at the 

bottom of the window. 

7. When you are done defining conditions, click OK. 

8. To remove filters, clear the Filter check box. 

Note: NetX360 remembers your filter criteria for future sessions. 

Display Data as a Chart 

Some account workbook detail pages can be viewed as a chart. Chart options display on the View menu, 

which appears above the data grid for applicable data views. 

1. Click View above the data grid. Available chart views display. 

2. Select the desired chart option and click Apply. The chart displays to the left of the data grid. 

3. To remove the chart display, click View again, select the table view (first option), and click Apply. 
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Create a Custom Data View 

1. Click View above the data grid, then click Add/Edit Views (if available). The Manage View 

window displays. 

2. In the New View Name field, enter a name for the new view. 

3. Under Visible Columns, build the list of columns you want to display in your custom view. 

o To add a column, select it in the Hidden Columns list and click Add. You can click Add All to 

add all columns to your view. 

o To remove a column, select it in the Visible Columns list and click Remove. You can click 

Remove All to remove all columns from your view. 

4. When you are done, click OK. A confirmation message displays. Click OK again. 
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Customize the Account Data Summary 

The Account Data Summary at the top of all account workbook detail pages provides a customizable 

snapshot of account balances. 

 

Customize the Account Data Summary 

1. Click Edit in the upper right of the account balance snapshot. A list of available balance options 

displays. 

 

2. Select the balance options to include. 

3. To change the order of the selected options: 

o Move your mouse over the option you want to move. The move icon  displays. 

o Drag the option to the desired position. 

4. When you are finished, click away from the list to close it. 
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Add Comments to an Account 

Account comments display at the top of the account workbook to the right of the Account Information 

icon . 

 

If comments have not been added for the account, the Add Comments icon and link display. 

 

View or Add Comments to an Account 

1. Click Add Comments to the right of the Account Information icon . The Add/Edit Account 

Comments window displays. If comments have already been added to the account, you can view 

them here. 

 

2. Add or modify comments in the text field and click Save. The comments display at the top of the 

account workbook. 
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Access My Client View 

My Client View enables you to see exactly what your client sees on NetXInvestor™. This feature is useful 

for assisting clients with questions about the NetXInvestor website. From My Client View, you can also 

perform tasks such as resetting or unlocking a client’s password, resetting security questions, and 

managing One-Time Passcodes and contact methods. 

Access My Client View 

1. Click Tools > Other Applications > My Client View. 

Global search keywords: my client. 

2. In the View field, select how you want to search for the client account, and enter your search 

criteria in the adjacent field: 

o Subscriber ID - Client's full NetXInvestor subscriber ID 

o Account Number - Client's full account number 

o Client Name - Client's last name 

3. Click Display. A list of accounts that match your search criteria displays. 

4. In the Site Description column, select the NetXInvestor site you want to view. NetXInvestor 

opens in a pop-up, with the selected account displayed. 
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6. View Notifications 

Use NetX360’s notifications, Items for Attention (IFA) and alerts, to focus your attention on account-

related activity that matters to you. 

Items for Attention 

Items for Attention (IFA) is a consolidated source for viewing notifications, announcements and other 

open items for your client accounts. 

1. From the account workbook, display the Items for Attention page. 

 

2. Click a number link in the No. of Items column to display the items in that category. 

 

Alerts 

You can set up alerts in NetX360 to notify you about various types of work items and events. 
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Alert Types 

ALERT TYPE DESCRIPTION 

Status Change Status change alerts notify you of a change in the status of a work item. For example, 

you could set up an alert to notify you when a check request is rejected. 

Action Items Action Item alerts notify you about action items you need to complete. For example, 

you could set up an alert to notify you when a check request requires your approval. 

Custom Custom alerts notify you about transactions such as incoming cash, debit balances, 

billing, 529 plan account transactions and margin details. 

Market Market alerts notify you about: 

• Changes in the values of prices or trade volume. 

• News headlines related to specific investments. 

• Changes in exchange-related indices such as: Dow Jones Industrial Average™ 

(DJIA®), NASDAQ®, S&P 500®, and New York Stock Exchange (NYSE) composite, 

among others. 

You can enter the threshold values at which you would like to receive an alert. An 

alert is triggered when the threshold value is exceeded. 

FYI Items for 

Attention (IFA) 

Items for Attention (IFA) alerts notify you about new FYI IFAs related to your client 

accounts. 

Summary email Email summarizing all alerts within the selected time interval. 

Notification Methods 

Depending on the type of alert, you can select one or more of the following notification methods: 

• Email - Sends the alert as an email message. You can enter up to three email addresses. 

• Cell Phone - Sends the alert to your cell phone as a text message. 

• Pop-up Alert - Displays as a pop-up in NetX360. 

• Summary Email - Sends an email summarizing all alerts within the selected time interval. 

• Notification Center - Displays alerts in NetX360 Notification Center (see page 71). 

You can also view alerts via the Alerts interface (see below). 

View Alerts via the Alerts Interface 

1. Click Tools > Alerts. 

2. Select the tab for the type of alert you want to view. 

3. A list of alerts for the selected type displays. Unread alerts display in bold. 

4. If you want to filter the list of alerts, select the desired filters and click Filter Alerts. 

5. To view details of a specific alert, click the link in the Action column. 

6. To view account or firm (IBD) information, click on the link in the IBD # or Account # column. 
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View Alerts Via Notification Center 

Notification Center in NetX360 for Windows enables you to view alert notifications from one centralized 

place. Using Notification Center, you can: 

• View real-time notifications as you receive them 

• View the count of notifications under each category 

• Attach or detach the streaming notification panel 

• Mark the notification as read, de-emphasizing them while retaining them in view. You can also 

mark notifications as unread 

• Archive, removing them from view. You can also unarchive notifications 

• Search across all notification types or within a specific notification type 

• View details for a specific alert, where applicable 

• Take action on a specific alert, where applicable 

 

Prerequisite 

Notification Center acts an additional delivery mechanism for alerts. Before using Notification Center, you 

must configure alerts via Alert Setup. 

Set Up Notification Center for Alerts 

1. Click Tools > Alerts > Notification Methods Setup. 

2. Select Yes to enable Notification Center and click Save. 

3. Click Notification Methods Selected. 

4. In the Notification Center column, select the alerts you want to receive via Notification Center 

and click Save. 
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Access Static Notification Center and View Notifications 

The static notification center page displays all of the notifications you have received. The page displays 

the notification categories and the count of unread notifications available under a category. The page 

enables you to search for notifications, view details, mark a notification as read, and archive a notification. 

1. Click Tools > Notification Center. The Notification Center page displays. 

Global search keyword: notification. 

2. To view notifications across all categories, click All. 

Or 

To view specific notifications, click on the required category.  

Depending on the type of category, the following actions display for each notification: 

• Mark as Read or Unread – De-emphasize while retaining in view. 

• View Details – View details of a notification. 

• Take Action – Take action on a notification.  

• Archive or Unarchive – Remove from view.  

Access Streaming Notification Center Panel 

• On the NetX360 home page, click (Notification Center icon.) 

The streaming Notification Center panel displays the most recent notifications you have received. 

The panel also updates automatically as you receive notifications. From the panel, you can view 

the details of the notification, mark the notification as read, or archive the notification. You can 

also detach and reposition the panel to display as a stand-alone window, in a second monitor, for 

example. 

Detach or Attach the Streaming Notification Center Panel 

1. On the NetX360 home page, click (Notification Center icon.) The Notification Panel displays. 

2. To detach the panel and view as a stand-alone window, click (Detach icon) to the right of the 

panel. 

To attach the panel to NetX360, click  (Attach icon) to the right of the panel. 

Tip: Click the Notification Center link within the streaming panel to view the static Notification 

Center page. 

Search for Notifications 

You can search for any notification by providing partial text available in the body of the notification.  

1. Click Tools > Notification Center. The Notification Center page displays. 

Global search keyword: notification. 

2. Click All or the category you want to search. 

Tip: When you search All, notifications from all categories display. 

3. In the Search Notifications field, enter the text available in the body of the notification. 
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7. Shortcut Keys 

NetX360-Specific Shortcut Keys 

FEATURE SHORTCUT 

Check for NetX360 Updates F11 

Close current tab (applies to all except Home tab) Ctrl+W 

Equities/ETFs Trading F3 

Exit NetX360 Alt+F4 

Institutional Services ID Confirms Ctrl+I 

Lock NetX360 F7 

Mutual Funds Trading F4 

My Client View Ctrl+Alt+M 

Favorites/Tools/NetX360 Menu F10 

Order/Trade Status F8 

Quote Track F9 

Security Search Ctrl+Alt+S 

Tab: move to next open tab (left to right) Ctrl+Tab 

Tab: move to previous open tab (right to left) Ctrl+Shift+Tab 

Tab: new tab Ctrl+T 

General Shortcut Keys 

FEATURE SHORTCUT 

Copy Ctrl+C 

Cut Ctrl+X 

Paste Ctrl+V 

Print Ctrl+P 

Stop loading/refreshing the screen Esc 

Help (Learning Center) F1 

Rename F2 

Refresh F5 

Save As F12 



APPENDIX A: MANUALLY CONFIGURE NETX360 SETTINGS 

FOR INVESTMENT PROFESSIONAL USE ONLY. NOT FOR DISTRIBUTION TO THE PUBLIC. 

GETTING STARTED WITH NETX360 USER GUIDE 

74 

Appendix A: Manually Configure NetX360 Settings 

In the following scenarios, previously configured settings will be lost: 

• Migrate from NetX360 32-bit version to 64-bit version 

• Uninstall and reinstall of NetX360 

The sections below provide instructions on how you can check your existing settings before you begin 

your upgrade, download, and install. You can reconfigure these settings after the installation is complete. 

The following settings will be lost: 

• Remember My Device 

• Connectivity Settings 

• Allocation for Average Price Account Settings 

• Navigation Settings 

Remember My Device 

Note: You can enable this setting after you complete the upgrade or install NetX360, if desired. 

After you have uninstalled and reinstalled NetX360 or installed a 64-bit version of NetX360 for the first 

time, the device or computer will be treated as a new device. During this process, you must provide a 

One-Time Passcode or the answer to your security question when you log in to the new version of 

NetX360 for the first time. You can enable this setting during the login process and the device will be 

remembered for subsequent logins. 
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Connectivity Settings 

Note: View the existing connectivity settings before you upgrade or install NetX360. After you have 

upgraded or installed NetX360, change the connectivity settings if not using the default. 

The default connectivity setting is: Always Use Secure Port. If you use a different setting other than the 

default, please refer to the existing connectivity settings, make a note of them, and enter the same 

settings after you have uninstalled and reinstalled NetX360 or installed a 64-bit version of NetX360 for the 

first time. 

To view your existing connectivity setting: 

1. On the Login window, click Settings (Wrench icon.) 

 

2. On the Settings window, click Troubleshooting. 

 

3. Click Connectivity. The Connectivity window displays the current setting. 
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Allocation for Average Price Account Settings 

Note: View the existing settings before the installation and set up after the installation is complete.  

The last selected Round Type and Round By settings in the Allocation for Average Price Account 

screen will be lost and will revert to the default setting. If you use an average price account, you can look 

up the existing settings currently in place. 

To view the settings: 

1. Go to the average price account’s Order/Trade Status screen and view the order details. 

 

2. Click Allocate Order. 
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3. Click Rounding. 

 

Navigation Settings 

Note: Enable these settings after you have upgraded or installed NetX360. 

The following navigation settings will be lost when you have uninstalled and reinstalled NetX360 or 

installed a 64-bit version of NetX360 for the first time. You need to set up these settings after your initial 

log in to NetX360. 

• Remember Tabs 

• Recently Visited 

• Popup Window Location 

• Popup Window Resize 
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